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PLEASE NOTE: 
This user guide is quite long and detailed. If you find it difficult to follow, please refer to the simplified 
step-by-step instructions here: 
https://shop.tracks4africa.co.za/docs/gps-maps/gps-maps-installation/ 
 
Please don’t hesitate to contact us for assistance at sales@tracks4africa.co.za 

 
Before you get started, please read here 
Important points, all discussed in this document. 
  
Note - the T4A GPS Maps on SD Card: 

●​ Is compatible with Garmin GPS Units only 
●​ Allows Plug ‘n Play - you are good to go immediately 
●​ If your GPS unit does not have an SD Card slot, we do explain how to install the GPS Maps 

onto your PC, and then transfer them to your GPS. 
●​ The SD Card must be registered with us, you get one free upgrade and subsequent 50% 

discounts on gps maps - only on our online store 
●​ Take note of a few important settings on your GPS discussed in this document, in order to 

make the most of your T4A GPS Maps. 
●​ You can install the GPS maps onto your PC for viewing and trip planning - for this you will 

require free software from Garmin, namely BaseCamp, MapInstall or MapSource, all 
explained in this document. 

○​ Please make sure that your Operating System is up to date, and if you already have 
Garmin Software installed, like Basecamp, MapInstall or MapSource - make sure its the 
latest version please. 
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HOW TO USE THIS GUIDE 

See how to use the QUICK GUIDE SECTION as your point of 
reference 

 
Start by referencing the Quick Guide Section: 
 

 

See how each step in the QUICK GUIDE SECTION references the 
DETAILED STEPS IN THE APPENDIX 
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Also note, that if you do reference the Appendix, please be sure to follow the links to “Go 
Back to Quick Guide section” - don’t just continue into the next Appendix section - it may 
confuse you. 
 

 

 
Okay, let’s get started! 
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QUICK GUIDE SECTION - Start here 

 

1. How to use T4A GPS Maps (On SD CARD) on your Garmin GPS 

 
Step Summary Steps See Detailed 

Steps Here 

 

Step A Insert the SD card into your GPS See Appendix 
Item 1A for more 
info & images 

Video not available  

Step B Go to map settings and select only the T4A 
maps.  Do not select more than one type of 
map at a time. 
 

See Appendix 
Item 1B for more 
info & images 

Video not available 

Step C Check these extra settings on your GPS: 
●​ Set preference to Fastest Time / Fastest Route 
●​ Switch off Avoidances 
●​ Set Map detail to more 
●​ Ensure only the T4A Map is selected on your GPS 
●​ Look at our YouTube video “Setting up your GPS” 

See Appendix 
Item 1C for more 
info 

Setting up your 
GPS 

 

 

2. How to install T4A GPS Maps to your PC 
Why would you want to do this? 

●​ If you want to view your T4A GPS Maps on your PC, which will enable you to plan trips etc. 
●​ You have an older GPS unit which does not accept a Plug & Play SD card, you will need to 

install T4A GPS Maps on your computer and transfer the maps to your GPS.  
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Step Summary Steps See Detailed 
Steps Here 

 

Step A Install Free Software: MapInstall / BaseCamp / 
MapSource: 

See Appendix 
Item 2A for more 
info on this 
software, and to 
help you decide 
which one to 
install. 

See videos below 

 

BaseCamp: 
(Recommended) 

 
View the T4A GPS maps, plan trips etc. and transfer & 

receive maps, waypoints etc. to and from a GPS unit. (ie. 
the MapInstall function resides within BaseCamp too)  

 
Click here to download Garmin BaseCamp for free  

 
and then install it on your PC. 

 Install 
BaseCamp on 

Windows 

 
 

 

OR MapSource: 
(Older software, more popular than Basecamp) 

 
Please note: Before installing MapSource, you will have 

to install BaseCamp, otherwise the MapSource 
installation won’t work. 

 
MapSource allows you to view the T4A GPS maps, plan 

trips etc. MapSource can  transfer & receive maps, 
waypoints etc. to and from most Garmin GPS units - 
the Garmin Drive GPS units don’t always work with 

Mapsource. 
 

Click here to download Garmin MapSource for free  
 

and then install it on your PC. 
 

 
 

Video not available. 
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 AND/OR MapInstall: 
 

Note that “MapInstall” is a feature incorporated in 
BaseCamp. One can also download and install 

MapInstall separately, which purely transfers the GPS 
maps to your GPS Garmin Unit. You cannot view the 

GPS maps or do trip planning etc. in MapInstall. 
 

Click here to download MapInstall for free  
 

and then install it on your PC. 
 

 Install MapInstall 
on Windows 

 

 
 
 
 

 

Step B Read the SD card with your PC and go to the PC 
Install Files folder on the SD card, and run the 
EXE file to install the T4A GPS Maps onto your 
PC. 
 

See Appendix 
Item 2B for more 
info 

 

Step C Open and View the installed T4A GPS Maps on 
your PC, using: 

  

 

 
 

 *Note: You cannot access and view the maps via 
MapInstall - that is purely used to transfer the maps 

from your PC to your GPS Unit. 

  

 

BaseCamp: 
 

Summary Steps: 
●​ Open BaseCamp 

●​ In Menu: Maps (ie. select the maps you installed & 
want to view) 

 

 
See Appendix 

Item 2C for more 
info 

Video not available. 

 

 OR 
 

MapSource: 
 

Summary Steps: 
 

●​ In Menu > Switch to product (ie. to select map to 
you installed & want to view) 

 
See Appendix 

Item 2D for more 
info 

Video not available. 
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Steps A to C above are available on our 

Youtube channel. We suggest you go through 
the steps above first as there is some software 
you will need to install first that is mentioned in 

this video. 

 
Install T4A Maps on Windows (From 

SD Card) 
 

 

 

3. How to transfer T4A GPS Maps from your PC to your GPS 
Why would you want to do this? 

●​ You have an older GPS units which does not accept a Plug & Play SD card, you have installed 
the T4A GPS Maps to your PC as per the previous section number 2, and now you want to 
transfer the maps to your GPS.  

 

Step Summary See Detailed 
Steps Here 

 

First: Connect your Garmin GPS Unit to your PC via 
USB cable. 

  

 Uninstall any previous T4A GPS Maps from 
your GPS unit. 

See Appendix 
Item 3AA for 
more info 

 

Step A Open  MapInstall / BaseCamp / MapSource that 
you installed, and transfer the maps to your 
GPS. 
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Via MapInstall: (recommended option) 

 
Summary Steps: 

●​ Find Device 
●​ Choose device to install maps on (ie. internal GPS 

memory or SD Card) 
●​ Click ‘Customize’ 

●​ Select maps to transfer 
●​ Click ‘Continue’ 

●​ Click ‘Install’ 
●​ Click ‘Finish’ 

 
 
See Appendix 
Item 3A for more 
info 

 

Transfer T4A 
Maps to GPS 

using Windows 
 

 
 

 

OR via BaseCamp: 
 

Summary Steps: 
●​ Menu: Maps > Install Maps (ie. will initiate built-in 

MapInstall function) 
●​ Find Device 

●​ Choose device to install maps on (ie. internal GPS 
memory or SD Card) 

●​ Click ‘Customize’ 
●​ Select maps to transfer 

●​ Click ‘Continue’ 
●​ Click ‘Install’ 
●​ Click ‘Finish’ 

 

 
See Appendix 

Item 3B for more 
info 

See Video above on 
how to use the 
MapInstall function 
with Basecamp to 
transfer the maps. 

 

 
OR via MapSource: 

 
IMPORTANT TO NOTE: MapSource can  
transfer & receive maps, waypoints etc. to 
and from most Garmin GPS units - the 
Garmin Drive GPS units don’t always work 
with Mapsource. 

 
Summary Steps: 

●​ In Menu > Switch to product (ie. to select map to 
transfer to GPS unit) 

●​ Then: Tools > Map (ie. this is the Map Tool used to 
select maps on the screen - maps will turn pink when 

clicked on)) 

 
●​ Use Map Tool to select one or more maps. 

●​ Only the pink selected map areas will 
transfer to your GPS 

●​ Then: Menu > Transfer 

 
See Appendix 

Item 3C for more 
info 

Video not available. 
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●​ Send to Device 
●​ Find Device 

●​ Choose device to install maps on (ie. internal 
GPS memory or SD Card) 

●​ Ensure ‘Maps’ is ticked 
●​ Click ‘Send’ 

 

 

4. DON’T FORGET 

Ensure your SD Card is 
registered 

In order to qualify for your free 
upgrade and subsequent 
discounts on our online shop 
only! 
 

See Appendix Item 4A for more 
info 
 
See How to register your SD 
Card on YouTube: 

 
 

Read about our Free SD Card 
Upgrade Policy and discounts 
 

 See Appendix Item 4B for more 
info 
 
See this YouTube video for more 
info: 

 

Check out the T4A Africa 
Guide on your T4A GPS Maps 
SD Card 
 

 See Appendix Item 4C for more 
info 
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5. HELP with MapInstall/BaseCamp/MapSource 
For more information on how to use BaseCamp, please refer to Garmin’s help tutorials which can be 
find on their website. At time of this publication this information was available from the internet location 
below: 
https://support.garmin.com/en-US/?productID=52801&tab=topics  
 

Some important settings on BASECAMP 
 
Make sure your settings on Basecamp is the same as the settings on your GPS else you will get 
different results if transferring routes from Basecamp to your GPS unit. 
 
In order to view and see POIs (ie. Lodges, campsites, restaurants etc.) on your screen - make sure that 
your Map Detail is set to Highest. 

1.​ Open Basecamp - Go to top main menu - click on “View”, then “Toolbars” and then make sure 
“Detail Level” is ticked. See number 1 below. 

2.​ You will notice a small block pop-up on your screen - make sure you choose “Highest” from that 
drop-down list of options. 
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Style of Maps appearing in BaseCamp 
In September 2024 we released a new mapping style. Our new map style is by far superior to the old 
style (on a GPS). 
Although our new style has been well received by our users, a few people still prefer to use the old style 
on BaseCamp when doing Trip Planning. It is possible to therefore install the old style onto your 
PC/MAC for that purpose.  
 
(Note that the old style can still be transferred to your Garmin GPS unit – but we strongly advise you 
use our new style on your Garmin GPS, its much better!) 
 
Old Style as it appears on BaseCamp – pre version 24.10: 

 
 
New Style as it appears on BaseCamp – post version 24.10: The new style differentiates between 
road types visually with different colours, equivalent to our online map. 
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If you still prefer to use our OLD mapping style in BaseCamp for trip planning purposes, you 
can: 

Change your settings in BaseCamp to lower the detail level: 

 

Another option is to use our old style for BaseCamp by following these steps: 

1.​ Uninstall Previous Tracks4Africa Map Versions: 
○​ Always uninstall any previous version of T4A from the control panel on both Windows 

and Mac before installing a new version. 
2.​ Then to install the OLD style: Execute the current release file. During the installation: 

​  
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●​ On Windows: Untick “T4A Optimized style” 

 

●​ On MAC: Choose “T4A_Mac_Default_Installer" file from the T4A_Mac_Installer.zip file 
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Refreshing BaseCamp: (NB!!) 

○​ After uninstalling and reinstalling, you may still see old data when you first open 
BaseCamp. 

○​ For Windows: Press Ctrl + G twice to refresh. 
○​ For Mac: To reset to factory defaults, follow these steps: 

1.​ Go to BaseCamp in the menu. 
2.​ Select Preferences. 
3.​ Click on General. 
4.​ Choose Reset Factory Defaults. 
5.​ Confirm by selecting Restart. 

​​ Note on Data: 
○​ Resetting to factory defaults does not delete any saved items, like waypoints, routes, or 

tracks. Your important information will remain safe. 

 
Have a look at this document for more info. 

 
Return to Install the T4A GPS Maps on your PC 
 
Go Back to Quick Guide section 

 
 

 

6. T4A Videos to help you 
Find Videos: On our Youtube Channel. 
 
For Trip Planning  - see this playlist: 
 

●​ BaseCamp Basics Full Tutorial - A detailed tutorial on basics of BaseCamp & Tracks4africa 
Maps 

●​ MapSource Basics FULL Tutorial - A detailed tutorial on basics of MapSource & Tracks4africa 
Maps 
 

●​ Setting Up Your GPS 
 

Go Back to Quick Guide section  
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APPENDIX - DETAILED STEPS 
1.​How to use T4A GPS Maps (On SD CARD) on your Garmin 

GPS 

1A) Insert the SD card into your GPS 
 

T4A GPS Maps are distributed on a Plug & Play SD card. This is an SD card with T4A GPS 
Maps preloaded and ready to use in your compatible Garmin GPS. 

GPS Units without an SD Card slot: 
For older GPS units which do not accept a Plug & Play SD card, you will need to install 
T4A GPS Maps on your computer and transfer the maps to your GPS, using BaseCamp 
or MapInstall.  
These are all applications provided by Garmin. (Note: This free software is discussed 
further in this document namely “How to install T4A GPS Maps to your PC”) 

 
If you have a GPS which was manufactured in 2011 or later then you are advised to 
use the latest version of MapInstall to transfer maps from your Mac or PC to your GPS.  

 
Examples of older units that do not use an SD card are 276c, 76c and 60c.  

 
Please contact our sales office to assist you in this regard: sales@tracks4africa.co.za  

GPS Units with an SD Card slot: Inserting the SD Card: 
Switch off your GPS, remove any existing SD cards (keep in safe place). 

 
Insert the T4A GPS Maps SD card. Use either the Micro SD card plus Standard adapter 
or the Micro SD card depending on what type of SD card reader you have on your GPS. 
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Example - Using the Micro SD Card in a Garmin Unit: 
Extract the micro SD card from the adapter, and only insert the micro SD card into the 
Garmin GPS Unit. 

 

 
 

​ ​ YouTube Video: How to remove small SD Card from Big SD Card adapter. 
 
Go Back to Quick Guide section 

 

1B) Select Only T4A Maps on your GPS 
 

Switch on your GPS then: 
 

1.​ You may see the message as per below appear - choose "NO". 
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This means that the Garmin unit has picked up that there is an extra data file on the SD Card. In 
this case it has picked up on the Africa Guide, that is supplied by T4A, and included on our SD 
Cards. It is not necessary to install this onto your GPS unit, as you can access it directly from 
the SD Card. This file is about 30MB in size. See Appendix Item 4C for more info on the Africa 
Guide. 
 

2.​ You have to enable the T4A GPS Maps on your Garmin Device: If you have Street 
Navigation Maps on your unit on the internal memory, you cannot run T4A GPS Maps and 
your street maps at the same time. Please be sure to only select T4A GPS Maps if you want 
your unit to navigate you from our maps, or vice versa. (ie. Never use any two map products for 
the same area at the same time as it may result in conflicts. Simply select which one you need 
and switch the other off).  

​  
Depending on what GPS unit you have, the setting will differ from GPS range to GPS range. It is 
usually under the “Settings” and then “Mapinfo” on your GPS unit. For Nuvi and Zumo units, this 
can be found by clicking on the ‘spanner’ (Tools). Then select Settings>Map>MapInfo to get to 
the screen where map selection is made.  
 
If you have any previous versions of T4A GPS Maps installed on your GPS’s internal memory 
you will need to remove those maps. 
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See more examples of how to enable this setting on: 

●​ The newer Garmin Nuvi range 
●​ Garmin Montana range 

 
Steps on the newer Garmin Nuvi range: (Please note that the older Garmin Nuvi range will 
work differently to the newer units) 
 

●​ Switch on your GPS and select Settings on the home page. 
 

 
 

●​ Then select Map & Vehicle on the next page. 
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●​ On the next page, scroll down and select myMaps. All your installed GPS Maps will be listed 
here.  

 
 

●​ Enable the map you wish to use on your GPS by selecting the tick box. Remember that you 
may only have one map product enabled (ticked) otherwise the GPS won't know which map to 
use and will give navigation errors.  
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Steps on the Garmin Montana range:  
●​ On the homepage of the GPS, click on the arrow on the left-hand side of the screen.  

 
●​ Select Setup on the next page  

 
●​ Then select Map.  

 
 

●​ Click on Map Information and then Select Map.  
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●​ Click on the map you wish to enable on your GPS device.  
 

 
 

●​ Select Enable in order to have the GPS map of your choice enabled. Remember that you may 
only have one map product enabled otherwise the GPS will give navigation errors.  

 

 
 

 
Go Back to Quick Guide section 
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1C) Check these extra settings on your GPS 
 
Here are a few tips to get the most out of your T4A GPS Maps on your GPS:  
 
Switch on your GPS then check: (please note the options available on the GPS units may differ 
between various models) 

 
   1. Route preference: Route Calculation should be set to: 

●​ Fastest Time / Fastest Route / Minimise Time  
○​ The GPS will take you on the fastest routes such as main gravel or tar, rather 

than on 4x4 tracks, two-spoor etc. 
○​ Note that the fastest time may not necessarily be the shortest distance 

  
●​ Shortest Time / Shortest Route / Minimise distance 

○​ The GPS will then always pick the shortest route, which will often include 4x4 
tracks, two-spoor etc.  

○​ Note that the shortest distance, over 4x4 tracks, may take longer to complete 
than a "fastest time" route, which may be longer but faster to drive. 

 
●​ Off Road 

○​ Take care here! Off road assumes that there are NO roads here, and draws a 
straight line from your position, to your destination. So it won't navigate along 
existing tracks. If you choose this option, and you see tracks, you can then just 
keep following them as you physically see in front of you, and make up your own 
mind which ones you want to use. It will require a lot more user decision making 
on your part. But it won't warn you that there may be a dead end, or if there is no 
connecting road to your destination. 

 
   2. Route preference: Avoidances, should all be switched off ie. unticked 

●​ Toll Roads: one can tick this one, and the GPS will keep you off highways with toll 
roads! 

●​ Unpaved Roads: If you want to go on gravel roads, this must be UNticked - remember 
the ones you tick, are the ones the GPS will avoid. So you tick toll roads, so the GPS will 
avoid toll roads. But UNtick unpaved roads, as you WANT to travel on gravel. Keep in 
mind your GPS will start looking for the shortest route as soon as you leave your 
destination, so you may want to toggle your Fastest Time and Avoidances settings as 
you travel, depending on what you want to do. 

●​ But it is not always an exact science - if you "select to avoid tolls or highways”, the GPS 
will select the best route and try to avoid tolls and highways as far as possible, but you 
may still travel through a toll or a highway if it is a more sensible route than avoiding it… 
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*Note on Shortest Route & Unpaved Roads: If you are using these settings, your GPS will always 
look for the SHORTEST route, regardless if it is tar or gravel, it will take you on the shortest route. If you 
tick "unpaved roads", you are telling the GPS to avoid “unpaved roads”, and if you tell it to use shortest 
route, it will take you the shortest route on tar only. If you tick "toll roads" and use shortest route, it will 
avoid toll gates (but it will not avoid other tar roads). 
 
*Note if you specifically want to travel backroads: Best practise is to tick Shortest Distance and 
untick ALL avoidances but always apply some brainpower too, check which routing the gps follows, 
don't just religiously follow the GPS. 
 
   3. Map Detail: Should be set to “More” or “Most” 
 
   4. Make sure that the Tracks4Africa map is the only map selected under your My Maps settings (see 
1B) Select  Only T4A Maps on your GPS) 
 
See this informative video from Garmin: Navigational Avoidances on Garmin Automotive Devices 
 
Make sure your settings on Basecamp/Mapsource is the same as the settings on your GPS else you 
will get different results if transferring routes/waypoints from Basecamp/Mapsource to your GPS unit. 
 
We do recommend that you plan your route on a computer where it is easier to see the gravel roads on 
Basecamp/Mapsource, and then send those POI's/Waypoints to the GPS and follow the 
POI's/Waypoints. 
It is essential that you create waypoints, and use the waypoints to create the route, and NOT use the 
routing tool in Mapsource/Basecamp to create the route, as we have encountered problems transferring 
the route created with the routing tool to the GPS, often it will not recalculate on the GPS. 
 
*POI/Waypoint (Is a Point of Interest like a campsite, fuel stop, restaurant etc) 
 
Go Back to Quick Guide section 

 

2. How to install T4A GPS Maps to your PC 

2A). More Info on Free Software: MapInstall / BaseCamp / MapSource 
*Note: Info and download links for this software is supplied in the Quick Guide Section 2, Step 2A, but read 
this section first. 
 
Garmin offers three seperate FREE map viewing software options: 
 

●​ BaseCamp: One can view the T4A GPS maps on this platform, plan trips, transfer & 
receive maps, waypoints etc. to and from a GPS unit. 
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●​ MapSource: One can view the T4A GPS maps on these platforms, plan trips etc. Note - 
To transfer & receive maps, waypoints etc. to and from a GPS unit is only possible in 
MapSource with T4A GPS maps versions 18.05 and older.  

 
●​ MapInstall. Which can only transfer maps to your GPS unit. Note that MapInstall is a 

feature incorporated into BaseCamp too. It can also be installed and used as a stand 
alone product to transfer maps to your GPS unit. 

 
You can choose to use any of the software, many people prefer MapSource as it is easier to 
use, although BaseCamp is the newer software, and MapSource may eventually be phased out. 

●​ Please note however: Before installing MapSource, you will have to install BaseCamp, 
otherwise the MapSource installation won’t work. 
 

●​ The T4A maps from version 18.10 onwards, can only be installed to Garmin Devices 
using BaseCamp and MapInstall. MapSource will only work up to T4A maps version 
18.05. You can therefore not use Mapsource to install maps to your GPS unit for our 
latest maps - but you can still use it for trip planning, and then use MapInstall to transfer 
maps to your GPS unit. 

 
The download links are provided in Section 2 was correct at time of publication. If you are 
unsure where to find these downloads, do a Google search for “Garmin BaseCamp” or “Garmin 
MapSource”. 

 
For more information on how to use BaseCamp, please refer to Garmin’s help tutorials which 
can be find on their website. At time of this publication this information was available from the 
internet location below: 
https://support.garmin.com/en-US/?productID=52801&tab=topics   

 
 
Go Back to Quick Guide section 

 

2B). Install the T4A GPS Maps on your PC 
 

1.​ On the SD card there are install files for your PC. Insert the SD card into an SD card 
reader. Some GPS units, digital cameras and mobile phones can be used as SD Card 
readers when connected to your PC via USB cable. The best option would be to use a 
dedicated SD card reader if your PC does not already have one. 

 
In this example, the Garmin GPS unit (with SD card inserted) is connected to the PC via 
USB cable. 
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2.​ Use Windows Explorer to browse the contents of the SD card, look in the folder called 
“PC Install Files”. You will find the installation file in this folder.  

​  
 
 
 

3.​ Select for example, T4A GPS Maps_Travellers Africa_XXXX.exe and run it (ie. double 
click on the exe file).  
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​  
​  

4.​ Follow the instructions on the install wizard: 
 
​ ​ Please Note: If your PC gives you a warning that the file you are about to run will  
​ ​ put your PC at risk - please do not be concerned - click on the link “More Info”: 

 

 
​ ​ Then click on “Run anyway”. 
 

If this is not available - take note that your firewall could be preventing you from 
running the file: Go to Windows Security/Windows Defender to fix the problem: 
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​ ​ The installation process will start - follow the on-screen instructions. 
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Note during this installation process - you will see this screen: 

 

 
 

The T4A Optimized Style includes our new mapping style. This is what we 
recommend you use on your GPS unit for an enhanced user mapping experience. For 
Trip planning purposes on BaseCamp, some users prefer the old style - see this section 
for more info on this in order to help you decide which style you want to install onto 
BaseCamp. If you are not going to do any trip planning on BaseCamp, then you can 
ignore this.  

 
 

​  
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​  ​ When done, click “Finish”, then Exit.  

Now T4A GPS Maps are installed on your PC.  
 

 
Go Back to Quick Guide section 

 
 

2C). Detailed Steps: Viewing the maps via BaseCamp 
Firstly, you need to open BaseCamp. 

 

 
 

BaseCamp will open up.  
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Go Back to Quick Guide section 
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2D). Detailed Steps: Viewing the maps via MapSource 
Firstly, you need to open MapSource. 

 
 

MapSource will open up.  
 

 
 

To view the Map/s in Garmin MapSource go to View > Switch to Product and 
select the T4A Map you would like to view. 
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The T4A map will now be displayed in your main window. You can zoom in and out, using the 
magnifying icons in your menu, or pan around on the map, using the small hand icon in your 
menu etc. 

 
 

 
Go Back to Quick Guide section 
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3. How to transfer T4A GPS Maps from your PC to your GPS 

3AA). Uninstall any previous T4A Maps from your GPS 
1.​ From your PC: Please access any old T4A map versions on your PC that 

you are now replacing via your Control Panel - and uninstall them from 
your PC! 

 
2.​ From your GPS: If the new T4A GPS map that you wish to install, is on your 

GPS unit, but in an older version, rather uninstall it from your GPS unit. 
Steps are here below. 

 
Please take care NOT TO uninstall your Garmap/City Navigation maps! 
 
Since your GPS unit is now connected to your PC -  
Open MapInstall or Basecamp and initiate the Map Install function from within 
Basecamp (ie. Go Maps/Install Maps). You will notice: 

●​ Your GPS device will be picked up 
●​ It will show the list of maps that it picked up in Basecamp that can fit onto your 

GPS unit 
●​ Click on “Customize” to continue... 
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Now you can customize your install to your GPS unit: 

●​ Keep your city navigation maps (garmaps) ticked so that you don’t loose them. 
●​ Untick all T4A maps / T4A Maps to be removed. 
●​ Then click on “Continue” 

 

​  
36 



 
 

 
 
Take note of the message here - you will install some (ie. your city navigation) and delete 
some (ie. the T4A maps). You will notice which maps will be: 

●​ Installed 
●​ Removed 

​ ​ Click on “Install” to continue. This will remove the maps you have unticked. 
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When the installation is done, you will see this screen, click on “Finish”. 
 

 
 
If you switch your GPS unit on now - go to your Map Info: you will notice only the maps 
that you did not remove in the “uninstallation process” are still there. 
There are no T4A Maps - as they have been uninstalled. 
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Go Back to Quick Guide section 

 
 

3A). Detailed Steps: Using MapInstall to transfer T4A Maps to your 
GPS 
Open MapInstall by launching it from your “Start” menu. (ie. if it is not listed in your Start menu, 
do a search on your PC for it). 

 
 

Please note that the MapInstall function is located within Basecamp as well - so you can access 
this functionality from within Basecamp, or you can open MapInstall directly on your PC. 
 
When transferring map/s to your GPS unit, MapInstall should be open and your 
GPS system switched on and plugged in.  
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Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be 
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on 
your SD card, transfer your T4A maps to the internal memory of your device and vice 
versa. 
 
Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your 
internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A 
file will not be transferred. (See steps here) 
 
Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card 
slots (ie. one for the camera and one for maps): 

●​ Be sure to remove the camera memory card to ensure that MapInstall will only see the 
Map Memory card, so that the maps can be loaded onto the correct memory card in the 
memory card slots. 

 
When MapInstall opens up, it should automatically list your GPS that is connected to your 
computer. If not, search for it in the dropdown list next to “Device”. 

 

 
 

If there is an SD card in the GPS unit, you will notice that MapInstall lists your Device name and 
the words “+SD Card” - see below. (ie. this means that the T4A maps will be installed on the SD 
card). 
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Then click “Customize” in the right bottom corner. 
 

Then select the maps you wish to transfer to your GPS. Then click on “Continue”. 
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Then click on “Install” in order to install the maps to your GPS unit. 

 
 

MapInstall will then continue with the installation process. 
When the installer has completed, click “Finish”. 

 
You are done - your gps maps should be installed on your GPS unit. 

 
 
Go Back to Quick Guide section 
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3B). Detailed Steps: Using BaseCamp to transfer T4A Maps to your 
GPS 
Open BaseCamp. 

 
When transferring map/s to your GPS unit, Basecamp should be open and your 
GPS system switched on and plugged in.  
 
Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be 
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on 
your SD card, transfer your T4A maps to the internal memory of your device and vice 
versa. 
 
Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your 
internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A 
file will not be transferred. (See steps here) 
 
Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card 
slots (ie. one for the camera and one for maps): 

●​ Be sure to remove the camera memory card to ensure that MapInstall will only see the 
Map Memory card, so that the maps can be loaded onto the correct memory card in the 
memory card slots. 

 
In BaseCamp, click on the menu item Maps > Install Maps: (ie. this is the MapInstall feature 
incorporated within BaseCamp) 
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You will notice that this then initiates the MapInstall function. Please follow the following steps 
on the screens to complete this process: 

 

 
 

Your Device name will then pop up in the Device list, and in the bottom window a list of all the 
possible maps that can be transferred and that will fit onto your GPS unit is displayed. 
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●​ If your device is not listed under the “Device” drop down list, then click on “Find Device” 
in order to allow your PC to read and recognise your connect GPS unit. (ie. if your GPS 
unit is not connect to your PC, then it will not appear in this drop down list). 

●​ Under “Device” you can choose to send the T4A GPS maps to your GPS units’ internal 
memory, or to the SD card (if you have one inserted into your GPS) which will be listed 
as “Removable Media” or “Removable Disk” etc. (Note: heed warning at beginning of this 
section in red about taking care not to overwrite Garmap or other maps already on your GPS). 

 
 

 
 

If there are multiple maps that appear in your list and you only want to send specific map/s to 
your GPS, then click on “Customize”. The following screen will appear where you can 
customize which maps you want to send by ticking the checkbox: 
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If you click “Continue”, MapInstall will show you what it is going to install, uninstall etc. on your 
GPS unit, for example: 

 
 

Click on “Install” to start the process. This screen will typically appear: 
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When completed, you can click on “finish” in this screen: 

 
 

 
Go Back to Quick Guide section 

 

3C). Detailed Steps: Using MapSource to transfer T4A Maps to your 
GPS 
IMPORTANT TO NOTE: MapSource allows you to view the T4A GPS maps, plan trips etc. 
MapSource can only transfer & receive maps, waypoints etc. to and from a GPS unit for T4A 
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GPS Maps version 18.05 and older...The latest T4A GPS maps cannot be transferred 
to/from a GPS unit with Mapsource. 
 
Therefore, if you have T4A GPS Maps version 18.05 or older then: 
 
Open MapSource. 

 
When transferring map/s to your GPS unit, MapSource should be open and your 
GPS system switched on and plugged in.  
 
Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be 
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on 
your SD card, transfer your T4A maps to the internal memory of your device and vice 
versa. 
 
Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your 
internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A 
file will not be transferred. (See steps here) 
 
Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card 
slots (ie. one for the camera and one for maps): 

●​ Be sure to remove the camera memory card to ensure that MapSource will only see the 
Map Memory card, so that the maps can be loaded onto the correct memory card in the 
memory card slots. 

 
1: In MapSource, go to View > Switch to product and select the mapset you wish to transfer. 
The map will be visible in front of you. If not, use the zoom button to zoom in or out to find the 
map on your screen. (ie. a previous step explains how to view and access the maps in 
MapSource) 

 
2: Go to Tools (at the top of the toolbar) and select ‘Map’. The Map tool is used to select the 
map/s you want to transfer to your GPS unit. 
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That will initiate the “Polygon” Map Tool icon - visible on your cursor: 

 
 

The T4A map is divided into 16 regions - depending on which map your purchased from T4A, 
you will notice the map light up in yellow as you hover your mouse over the different map 
regions. (ie. in this example below, the entire map was purchased, which includes all 16 
regions) 
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When you click on the map with the Maptool, the map will turn pink (see 
example below). If not, zoom in to the map in order to see the selected pin map area. 

 

 
 

 
 

If you want to transfer more than one map to your GPS system, repeat step 1 
and 2 above, by selecting the map(s) you want to transfer to your GPS unit.. 
If you’ve purchased the Full Map Set and you want to transfer the full set, please make 
sure that the 16 map sets is selected before transferring the maps. 
If you only want to transfer a few of the map tiles only, then select only those 
you want to transfer for example Namibia, Botswana or East Africa. 

 
3. To transfer the map/s to your GPS, select Transfer on the toolbar, and then 
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Select “Send To Device”. 

 
 

The “Send To Device” pop up screen will appear:  
●​ If your device is not listed under the “Device” drop down list, then click on “Find Device” 

in order to allow your PC to read and recognise your connect GPS unit. (ie. if your GPS 
unit is not connect to your PC, then it will not appear in this drop down list). 

●​ Under “Device” you can choose to send the T4A GPS maps to your GPS units’ internal 
memory, or to the SD card (if you have one inserted into your GPS) which will be listed 
as “Removable Media” or “Removable Disk” etc. (Note: heed warning at beginning of this 
section in red about taking care not to overwrite Garmap or other maps already on your GPS). 

●​ Ensure “Maps” is ticked, as this is what you want to send to your GPS. 
●​ Then click “Send” to transfer the maps to your device. 
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When completed, the T4A GPS Maps will now be available on your GPS unit. 
 

 
Go Back to Quick Guide section 

 
 

4. DON’T FORGET TO: 

4A). Register your SD Card 
In order for us to provide you with a free upgrade and subsequent discounts, you need to 
register your SD card on our site. (Please refer to the section further below titled “Read about our SD 
Card GPS Map Releases & Free Upgrades” for more information on free upgrades). 

 
●​ If you purchased your SD card online from us: please check as follows if your SD 

card is registered: On our online shop, login in: 
○​ Go to “My Account” 

■​ Orders 
●​ View the Order for the SD Card purchase (The SD Card Serial 

Number & Product Code will be visible there). 
 

●​ If you purchased your SD card from a retailer: you need to register your SD card on 
our online store. See steps further below. 
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If you require any assistance in this regard contact us at sales@tracks4africa.co.za 

 

Steps on how to register your SD Card: 

Have your SD Card packaging handy 

 

Registering your card on our online shop 
You can register your SD card here on our online shop:  
Go to Shop>GPS Maps (SD Cards)>Register an SD Card 
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Follow the screens and complete the form on your screen in order to register your SD Card.  
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​  
55 



 
 

 
 

Help with registering your SD Card 
Please contact us at sales@tracks4africa.co.za with your request, and please provide: 

1.​ Your name and surname 
2.​ Email address 
3.​ SD Card Serial Number (on outside of packaging) 
4.​ SD Card Product Key / No (on inside of packaging) 

 
 
Go Back to Quick Guide section 

 

4B) Read about our SD Card GPS Map Releases & Free Upgrades 
When you purchase an SD Card it entitles you to 1 free upgrade on the following version only, and 
then further 50% discount purchases on any other subsequent versions of SD Card / Subscriptions for 
a complete set of Downloadable GPS Maps. 
 
Note: Tracks4Africa can only offer you a free upgrade etc. if your purchase is registered on our 
system: Please refer to the section in this document titled “Register your SD Card”. 
 
At Tracks4Africa, we officially update our GPS maps on SD Card for Garmin units twice a year, 
every May and October: 
 

●​ Our 2025 May release version will be named “25.05” (ie. 2025 May month release) 
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●​ Our 2025 October release version will be named “25.10” (ie. 2025 October month release) 
 
You will be notified via email, when a new release is available, which will contain a link to our online 
store checkout, where you will have a 90% OR 100% free coupon to claim: 

●​ On SD Card couriered to you with a 90% free coupon (ie. Note the remaining 10% is for 
us to recover our cost of the actual SD card and you will pay the courier costs)  
OR 

●​ Via a Download link with a 100% free coupon (ie. You will be emailed a zipped file 
containing the full set of T4A GPS Maps in an .exe file) 

 
For more information please refer to this page on our shop. 
 
Go Back to Quick Guide section 

 

4C) Check out the T4A Africa Guide on your GPS 
The Africa Guide is a digital file that is included on the T4A GPS Maps SD Card. It contains information, 
where available, on the POIs (Points of Interests eg. Lodge, Campsite, Restaurant etc.) that are on our 
GPS Maps.  
 
This Africa Guide can be accessed under "Extras" on your compatible Garmin Device. 
 

This Africa Guide enables you to look up descriptions, contact details, rates, facilities and activities on 
offer for lodges and campsites in Africa directly on your GPS. Also included are searchable picnic 
sites and border control information, perfect for your next road trip. 

 

You can also look up information on various attractions (eg. wine farms) and activities (eg. 4WD-trail) 
that exist as Points of Interests (POI) on our maps. 

Note: we no longer publish photos on this guide, as it increases the size of the guide tremendously, and 
will then take up to much space on a GPS unit. 
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See the category "Communications": use this to find the nearest point selling airtime, offering internet 
access, or wireless, or where the nearest public phone is, or a good mobile reception spot. 

Also see our "Shopping" category: to help you find your nearest shop of choice, and the nearest place 
selling gas. 

For more information on this guide, please have a look on our website here. 

Go Back to Quick Guide section 
OR 
Go Back to New Extras Data Found on Card message 
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